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Introduccion

La presente publicacidn es una obra que tiene el objetivo de presentar la Ultima version de AutoCAD 2015
y dar a conocer simple y gradualmente los comandos para realizar disefios de proyectos en cualquier
especialidad como mecanica, civil, topografia, eléctrica, entre otras.

AutoCAD 2015 esta dividido en 23 capitulos, en los cuales se describen desde los conceptos mas
elementales, que permitiran gradualmente adquirir la base de este desarrollador, hasta los mas
avanzados que posibilitaran la realizacion de disefios especializados.

En esta obra se encuentra apoyo para el desarrollo de dibujos en dos o tres dimensiones, para
complementar un curso de capacitacion, en su aprendizaje, y también como consulta de comandos;
ademads de ello, da a conocer la adquisicion de atajos para una mayor rapidez a través de opciones
nuevas, asi como las mejoras de los ultimos afios y las novedades de AutoCAD 2015 para su desarrollo
profesional. Cabe resaltar que el libro va acompafado de un CD de ayuda, que contiene archivos de
practica sobre las ultimas novedades que le permitira entender mejor esta version.
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1.1 REQUERIMIENTOS DEL SISTEMA

1. Requisitos del sistema para AutoCAD 2015 de 32 bits

Descripcion Requisito

Sistema operativo Service Pack 3 (SP3) o posterior de:
A Microsoft® Windows® XP Professional

A Microsoft® Windows® XP Home
Los sistemas operativos siguientes:

A Microsoft Windows 7 Enterprise
Microsoft Windows 7 Ultimate
Microsoft Windows 7 Professional
Microsoft Windows 7 Home Premium
Microsoft Windows 8
Microsoft Windows 8 Pro

> = > > = >

Microsoft Windows 8 Enterprise
A Microsoft Windows 10

Navegador Internet Explorer® 7.0 o posterior

Procesador Windows XP:
Procesador Intel® Pentium® 4 o AMD Athlon™ Dual Core de 1,6 GHz o superior con
tecnologia SSE2

Windows 7 y Windows 8:
Procesador Intel Pentium 4 o AMD Athlon Dual Core de 3,0 GHz, o superior con
tecnologia SSE2

Memoria 2 Gb de RAM (recomendado: 4 Gb)

Resolucién de 1024 x 768 (1600 x 1050 o superior recomendado) con color verdadero
visualizacion

Espacio en disco Instalacion: 6,0 Gb

Dispositivo sefialador Admite ratones de Microsoft

Soportes Descarga e instalacion desde DVD

Requisitos adicionales  Procesador Intel Pentium 4 o AMD Athlon de 3,0 GHz o superior; o procesador
para modelado en 3D Intel o AMD Dual Core de 2,0 GHz o superior
4 Gb de RAM
6 Gb de espacio libre en el disco duro (sin incluir los requisitos de instalacion)
Adaptador de pantalla de video de 1280 x 1024 con color verdadero de 128 Mb o
superior, Pixel Shader 3.0 o superior y tarjeta grafica compatible con la estacién de
trabajo Direct3D®.

Nota: Se recomiendan los sistemas operativos de 64 bits cuando se trabaja con
grandes conjuntos de datos. Consulte los requisitos para sistemas de 64 bits de
AutoCAD LT para obtener mas informacién.

NET Framework .NET Framework versién 4.0, Actualizacion 1
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2. Requisitos del sistema para AutoCAD 2015 de 64 bits

Descripcion Requisito

Sistema operativo Service Pack 2 (SP2) o posterior de:
A Microsoft® Windows® XP Professional*

Los sistemas operativos siguientes:
A Microsoft Windows 7 Enterprise

Microsoft Windows 7 Ultimate
Microsoft Windows 7 Professional
Microsoft Windows 7 Home Premium

Microsoft Windows 8

> > > >

Microsoft Windows 8 Pro

A Microsoft Windows 8 Enterprise
* Nota: VBA no es compatible con Windows XP Professional.

Navegador Internet Explorer® 7.0 o posterior
Procesador AMD Athlon 64 con tecnologia SSE2
AMD Opteron™ con tecnologia SSE2
Intel Xeon® compatible con Intel EM64T y SSE2
Intel Pentium 4 compatible con Intel EM64T y tecnologia SSE2
Memoria 2 Gb de RAM (recomendado 4 Gb)
Resolucion de 1024x768 (1600x1050 o superior recomendado) con color verdadero
visualizacion
Espacio en disco Instalacion: 6,0 Gb
Dispositivo sefialador Admite ratones de Microsoft
Soportes Descarga e instalaciéon desde DVD

Requisitos adicionales 4 Gb o mas de RAM

para modelado en 3D 6 Gb de espacio libre en el disco duro (sin incluir los requisitos de
instalacion)
Adaptador de pantalla de video de 1280x1024 con color verdadero
de 128 Mb o superior, Pixel Shader 3.0 o superior y tarjeta grafica
compatible con la estacion de trabajo Direct3D®.

NET Framework .NET Framework versién 4.0, Actualizacién 1.
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1.2 INICIO DEL PROGRAMA

Para iniciar el programa hacer doble clic al icono de acceso directo.

| Abrir
& SkyDrive Pro v

Abrir la ubicacién del archivo

Enable/Disable Digital Signature c!
) . & Ejecutar como administrador
O hacer clic derecho en Abrir.

Solucionar problemas de compatibili

Anclar a Inicio

B Afadir al archivo...

| B Afadira "acad.rar®

|B Afiadir y enviar por email...

| B Afiadir a "acad.rar” y enviar por emsil
Anclar a la barra de tareas
Enviar a {
Cortar
Copiar
Pegar

Crear acceso directo
Eliminar

Cambiar nombre

Propiedades

Programas (8)

| A AutoCAD 2015 - English

A AutoCAD 2015 - Espafiol (Spanish)

T Export AutoCAD 2015 Settings__|
{4 Exportar pardmetros de AutoCAD 2015

i+ Import AutaCAD 2015 Settings

[+ Importar pardmetros de AutoCAD 2015

rlj‘ License Transfer Utility - AutoCAD 2015

También puede ingresar al men( Inicio y escribir kKAUTOCAD»;
Documentos (4)

B sisiocanznns luego, seleccione la opcién AutoCAD 2015 — English.
L

 PTXML
. R200
Lé‘] CertificationDB.xml

Archivos (3)

{8 AutoCAD_2015_Spanish_LP_Win_64bit_dim.sh.exe
8 AutoCAD_2015 Spanish_LP_Win_64bit_dim.sfr.exe

J2 Ver mis resultados

Buscar

AUTOCAD|

En t

ENtoCAD 2015 - Englishi

. . B AutoCAD 2015 - English
Otra manera de ingresar es en el mend Buscar, donde debera

seleccionar la opcién AutoCAD 2015. e
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Cargara automaticamente y aparecera la imagen de AutoCAD 2015.

Luego aparece una ventana de bienvenida donde se nos invita a un programa de participacion del
usuario del Autodesk, donde podra compartir su experiencia con el software y dar su apreciaciéon con

respecto a los comandos usados.
Seleccione «No, | do not want to joint the program at this time» y haga clic en OK.

Autodesk Customer Involvement Program

{\ AUTODESK.

Wel to the Cust T t Prog
Autodesk invites you to join this program, which helps us design better products. If
you agree to participate, there is no commitment of time or work on your part. We
simply gather information from your computer about your system and on how you
use our products, as part of a broad sample of user activities.

llected is used to i or contact you. You

; G
: program at any time through the Help menu.
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A continuacion, aparece una nueva ventana. Haga clic en OK.

New Tab

Desktop Analytics Program

{\ AUTODESK.

_—lnlme,pfthe information we collect is used to identify or contact you. Thanks for

Desktop Analytics Program

Autodesk would appreciate your participation in Desktop Analytics to help make
our products more effective in meeting your needs. If you join in, we simply collect
non-personal product usage information from Autodesk software.

The information Autodesk collects is as follows: the product used, session length,
country location, document type, document size, and whether the document was
opened from local storage or Autodesk 360 storage.

your consideration.

Learn more
Privacy Statement

Annotation v

2 Signin

Block ~ 2 s 3 Clipboard

Sign In to Autodesk 360
Access online services

Send Feedback
Help us improve our products

Send Feedback
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Ingrese al entorno de AutoCAD 2015.

Autodesk AutoCAD 2015 Drawingl.dwg

| g
Home 3 2 [

i &-
LS -
Modify ~

Type a command
MODEL

En la parte inferior derecha de la pantalla, tenemos un icono parecido a un timén, llamado Workspace
Setting, que nos permite acceder a tres diferentes configuraciones de las herramientas de AutoCAD
segln sea el disefio a elaborar, es decir, si es un disefio en dos o tres dimensiones.
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Otra manera de acceder a diferentes configuraciones es haciendo visible el icono Workspace, que se
encuentra oculto.
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1.3 ESPACIO DE TRABAJO - MODEL SPACE
m Partes de la pantalla
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Proporciona una ubicaciéon simple y compacta para ejecutar cualquier comando en el espacio de
trabajo. Esta configuracion tiene una organizacion de fichas (tabs) y paneles (panels), que podemos
visualizar al hacer clic derecho sobre los bordes de la cinta ribbon.
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Ademas, puede arrastrar un panel y colocarlo como flotante.
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2. Cursor

El cursor nos permite seleccionar objetos, iconos y opciones; su tamafio se puede modificar con el
comando CURSORSIZE.

Solo presione escape dos veces y escribe el comando CURSORSIZE, luego presione Enter.

Luego escriba un nimero entero con un rango del 1 al 100; si escribe 100, sera el cursor 100 %
en pantalla total. Presione Enter.
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El tamafio normal del CURSORSIZE es 5.

Es el area principal de trabajo; es limitada, ya sea en 2D o 3D, y su color, presentacion y estilo de
visualizacion dependen del espacio de trabajo a usar.
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4. Linea de comandos

Nos permite visualizar c6mo interactda el usuario al ejecutar un comando con el software. Para
escribir dentro de ella basta con presionar Esc dos veces y escribir el comando a ejecutar. Para
restablecer la linea de comandos basta presionar las teclas Ctrl + 9.
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Con la tecla F2 se puede extender la linea de comandos.

Command: *Cancel*
Command: *Cancel*
Command :

Command: '_-view Enter an option [?/Delete/Orthographic/Restore/Save/
sEttings/Window]: _swiso Regenerating model.

Command: *Cancel*
Command: *Cancel*
Command :

Command: *Cancel*
Command: *Cancel*

Command:

Command: *Cancel*

Command: *Cancel*

Command: *Cancel*

Automatic save to C:\Users\UNIMASTER\appdata‘\local\temp
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Command: *Cancel*

Command :
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5. Barra de estado

En ella se muestran las funciones mas importantes del AutoCAD; consta de 29 opciones,
considerando el Ultimo modo que permite colocar visible cada modo (icono—bot(’)n) para su
visualizacién y el modo Isolate Objects.

Customization

Isolate Objects

De izquierda a derecha tenemos:

v Coordinates

v Model Space

v Grid

v Snap Mode

v Infer Constraints
v Dynamic Input

v Ortho Mode
v Polar Tracking
v Isometric Drafting

v Object Snap Tracking
v 20 Object Snap

¥ LineWeight

v Transparency

v Selection Cycling
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v Selection Cycling

v 3D Object Snap

v Dynamic UCS
v Selection Filtering

v Gizmo

v Annotation Visibility
v AutoScale

v Annotation Scale

v Workspace Switching
v Annotation Monitor
v Units

v Quick Properties

' Graphics Performance

v Clean Screen

A 11~ 8@ ~ 4| F Decimal ~

Se llama Barra de estado porque cada modo tiene dos estados: encendido - on, que adopta el color
azul; y apagado - off color gris, que podemos modificar haciendo clic sobre el modo, cambiando
su color y estado.

Permite controlar de manera rapida diferentes formas de visualizacién de los objetos. En esta
etiqueta tenemos tres corchetes. En el primer corchete podemos configurar la visualizacion de los
navegadores que se visualizan en la parte derecha del espacio modelo.

Drawing!*
[=]Top][2!

Restore Viewport

Viewport Configuration List »
s
‘ | ViewCube -l

SteeringWheels

Mavigation Bar




¥ AutoCAD 2015

Ademas, podemos obtener ventanas mdltiples en el espacio modelo. Por ejemplo, seleccione el
corchete y luego la opcion Viewport Configuration List; de esta lista seleccione la opcion Three:
Below, y obtendra tres ventanas en el mismo dibujo.
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Three: Vertical
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Four: Equal
Four: Right
Four: Left

Configure...

Asi, obtenemos la siguiente pantalla:
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Para retornar a una sola vista, seleccione la opcion Single de la lista
de configuraciones, que es la primera.
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En el segundo corchete podemos modificar las vistas para dibujos en 3D del dibujo, por ejemplo,
abriendo el archivo CO1 TEMPLO 3d, presione las teclas Ctrl + O y seleccione el archivo.
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Luego, haga clic en el segundo corchete y seleccione SW Isometric.

Autodesk AutoCAD 2015
Manage  Output d-ins

7 -
.

Text
aL T @ Properties

Draw + v y Annotation *

Right
Front

Back

SW Isometric
SE Isometric

NE Isometric
(¢
NW Isometric WY
ARRR

View Manager...

Parallel

Perspective




¥ AutoCAD 2015

Asi, se obtiene la siguiente pantalla:
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En el tercer corchete obtenemos los estilos visuales para la mejor visualizacién de dibujos 3D.
En el archivo anterior, haga clic en el tercer corchete y seleccione la opcion Shaded.
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Asi, se obtiene la siguiente pantalla:
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Esta herramienta permite cambiar el punto de vista del espacio modelo, WCS (sistema
coordenadas universales), permitiendo también recuperar UCS grabados.

En el archivo anterior, seleccione la casita.
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De esta manera, obtendra lo siguiente:

't 8 Signin

€01 TEMPLO 3D.dwg
3 BIM 5=

Utilities ~

Esta barra permite tener a nuestro alcance opciones rapidas de visualizacién; asi, tenemos la
opciéon 3D Full Navegation Wheels y Orbit, que se usara para para proyectos en 3D. Ademas,
tenemos el comando Pan, para mover la pantalla, el Zoom y el Show Motion.

Use el Orbit para cambiar la vista solo con el cursor, como en el dibujo anterior.

C01 TEMPLO 3D.dwg

Free Orbit
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Haciendo clic, y sin dejar de presionar, puede cambiar la vista 3D.

m Paleta de herramientas

La paleta de herramientas nos permite acceder a comandos en forma directa.

Paleta «Tools pallets»

Esta paleta se puede obtener presionando el Mo
las teclas Ctrl + 3, o seleccionando el P FECEe e
icono que se ubica en la ficha View y en el
panel Pallets.

Press F1 for more hél

& o

um

De esta manera obtenemos la siguiente pantalla:

B 2D Align
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Estas paletas se pueden esconder automéaticamente con la opcion Auto—hide. También se pueden
personalizar, crear nuevas, etc.

it

’ |
2D Spiral Auto-hide

Paleta «Properties»

Esta paleta permite obtener todas las propiedades y caracteristicas de un objeto seleccionado, sea
el objeto 2D o 3D, y asi conocer y modificar ciertos parametros de los objetos seleccionados.

Esta paleta se puede obtener con las teclas Ctrl + 1, o también seleccionando el icono que se ubica
en la ficha View y en el panel Pallets.

Opens or closes the Properties palette

[z PROPERTIES
Press F1 for more help

Plot style
Fll =
Pl

Plot ta... |

View

Esta paleta nos permite organizar los dibujos en proyectos donde se involucran muchas especialidades,
como arquitectura, mecanica, electricidad, estructuras, cimentacién, automatizacion, etc. Ademas,
permite crear hojas con membretes automaticamente, indices de planos, imprimir todos los planos
a la vez, etc.
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Esta paleta se puede obtener con las teclas Ctrl + 4, o también seleccionando el icono que se ubica
en la ficha View y en el panel Pallets.

Opens or closes the Properties palette

‘s PROPERTIES
Press F1 for more help

Open...

Sheets

x
]

1.4 USO DE BOTONES DEL MOUSE

BOTON I
- DERECHO

-

’
BOTON
IZQUIERDO I

Abrir el archivo CO1-SCROLL.dwg.
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m Boton izquierdo

Se utiliza para seleccionar objetos y capturar puntos de pantalla.
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[1.42 Botén derecho

Permite acceder al mend contextual. En muchos comandos equivale a la tecla Enter.

143 Scroll_4

Al girar la rueda hacia adelante o hacia atras, los objetos se reducen o se amplian, lo que equivale al
comando Zoom, la opcion Realtime.
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Paste

Clipboard

CO1-SCROLLY

SN 5 - 130 o comnand

Esto se puede repetir hasta que ya no se pueda reducir;, para solucionar
esto, simplemente escriba el comando Regen y presione dos veces Enter para
restablecer las funciones del Scroll.

Si se presiona sin soltar la rueda hacia abajo, aparece una manito que equivale al
comando Pan, que permite mover la pantalla. Para salir del comando presione Escape.

Se tiene el dibujo reducido.

PN 55 1y0c o comand
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Si presiona como un timbre el Scroll dos veces, el dibujo se centra en la pantalla que equivale al
comando Zoom, la opcién Extents.

1.5 EMPEZAR UN DIBUJO EN FORMA CORRECTA

Al ingresar al entorno de AutoCAD, aparece un espacio de trabajo con caracteristicas propias. Estas
caracteristicas estan guardadas en un dibujo llamado plantilla (templete).

Las plantillas de dibujo tienen la extension dwt. Existen varias plantillas ya creadas por el AutoCAD,; el
usuario también puede crear sus propias plantillas segin sean sus requerimientos.

Las plantillas pueden contener capas, bloques, estilos de texto, estilo de dimensionado, membretes,
etc.

Las plantillas tipicas son acad y acadiso; sin embargo, cuenta con 2 plantillas adicionales para 3D:
acad3d y acadiso3d, que cuentan con los mismos tamafos que las que estan en dos dimensiones.

Caracteristicas vs plantillas Acad-acad3d Acadiso-acadiso3d
Tamafio de la hoja (limits) 8x11 420 % 297
Tamafio de la rejilla (grid) 1 10
Tamafio de los textos 0.25 2.5
Salto del cursor 1 10
Estilo de cota Standard 1SO-25

Al iniciar el AutoCAD, esta por defecto la plantilla acadiso. Asi, aparecen los valores ya configurados.

Si se trabaja en otro programa de la familia de Autodesk (Inventor, AutoCAD, 3D Civil, Revit, Watercad,
etc.), estos leen otra plantilla especial. Para iniciar un nuevo dibujo de AutoCAD en dicho programa,
una manera practica es escribir el comando stratup, le da el valor 1 y hace un dibujo nuevo (file-new)
escogiendo un dibujo en imperial (unidades inglesas) o metric (unidades métricas).+

S
(ce]
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A Select template E
Lookin: | J, Template v € B @ X B Vews - Tods ~
Nombre i Fecl | Preview
g |) PTWTemplates 2/
J1 ShestSets 2/
pieg frg acad -Named Plot Styles 09/(
g cad -Named Plot Styles3D 09
cad 09/(
E [ acad3D 09/
[j [l acad|SO -Named Plot Styles 09/(
cadISO -Named Plot Styles3D 09/t
cadiso 09/
\‘ cadiso3D 09/
utorial-iArch 09/t
uterial-iMfg 09/(
Eﬂi b Tuterial-mArch 09/
[ Tutarial-mMfg 09/
< >
Flename: | TEE V][ Open |+
Fles of type: | Drawing Template [ dwt) || Cancel

151 Recomendaciones

Si se va a dibujar un plano cuyas medidas son pequefias, por ejemplo, una oficina o edificacion tipica
en metros, es conveniente usar la plantilla acad; pero si se tienen medidas grandes tipicas en metros,
por ejemplo, una pieza mecanica en milimetros, entonces es mas conveniente usar la plantilla del
acadiso.

Como el AutoCAD carga por defecto la plantilla acadiso, los limites y los demas parametros estan
predefinidos; sin embargo, las unidades son «unidades de dibujo de AutoCAD», y el usuario es el
que establecera si dichas unidades representaran metros, milimetros, centimetros, kildmetros u otra
unidad de medida segln sea el requerimiento del disefio.

152 Como ordenamos nuestro entorno en AutoCAD 2015

En los centros de ensefianza ocurre con frecuencia que el usuario anterior deja desordenado el
entorno para el siguiente usuario.

1. Escribir en la ventana de comandos el comando Options.

[ 0P (OPTIONS)

(= OPEN
OPTCHPROP

& OPENSHEETSET

B~ Type a command

2. Seleccione la ficha Profiles.

3. Seleccione el botén Reset.

4. Seleccione Si.
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5. Seleccione Ok.

A Options ﬁ
Curment profile: <<Unnamed Profile>> j Cument drawing: Drawing1.dwg
| Files | Display | Open and Save | Piot and Publish | System | User Preferences | Drafting | 3D Modeling | Selection | Profiles | Oniine
Auailable profiles: ,,‘
cilinamed Proile
AutoCAD Delete
You are resetting a profile in use,
which will reset the state of AutaCAD.
Do you want to continue?
:,'
4
-
-
-
-
-
[ ok Cancel | [ Ay || Hep

El ordenamiento se obtiene en el entorno Drafting & annotation.

1.6 INTERFAZ DEL USUARIO

A partir de la version 2009, donde aparece la cinta ribbon, la interfaz del usuario ha mejorado mas en
esta version del AutoCAD 2015, donde han aparecido nuevas fichas (tabs) y paneles (panels); ademas,
tenemos la barra de herramientas de acceso rapido (quick access), el selector de configuraciones
(workspace switching), etc.

161 Elementos de la interfaz del usuario

© Menii de aplicacion — Aplication menu

“
Draw ~ %
b Y

Drawing1*
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En esta ventana tiene los comandos New, Save, Save as, Export, Publish y Print.

=

o

@ Publish

5 Drawing
Utilities

Autode:

(&) Recent Documents
By Ordered List

Floor Plan Sample.dwg

'S [= Data Extraction and Multileaders
= sample.dwg

Assembly Sample.dwg

[options | [ Exit Autodesk autocan 2015

Ademas, permite buscar comandos con sus opciones y ejecutar el comando, por ejemplo, si escribe
«CIRCLE» y luego seleccione 3 puntos en pantalla. Obtendra una circunferencia que pasa por 3

puntos seleccionados.

CIRCLE

Matches for: "CIRCLE™
Best Matches

@ Circle
@ Circle

Ribbon Tab: Home > Draw > COg

Ribbon Tab: Home > Draw > Circle

(&) Radius  Aibb
® Diameter Aib/|
Jogged Ribb

= Measure Fibb)

CJ' Circle Ribbon Tab: Home > Draw > Circl
‘ (# Circle Ribbon Tab: Home > Draw > Circle Flyout > 3-Point
i Circle 20 3_point
4 Cirel ’.‘ Rib| Creates a circle using three points on the circumference
7,
Related Reeflts For example:
@ 3&ut
4
(‘E Offset

7n CIRCLE

Press F1 for more help
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Asi, se obtiene la siguiente pantalla:

Usando el campo de busqueda, se pueden incluir ayudas rapidas,
mensajes de comandos en cadena de textos o etiquetas.

|ITEMS *®|

Matches for: “ITEMS™
Related Results

| I Purge

%2, Reset Array

< Array Method Divide

52 Replace ltem

Array ftems

© Documentos recientes — Recent documents

Los documentos recientes se muestran en imagenes pequefas, ordenadas por fecha de modificacién,
informacion de la version. Ademas, se pueden agrupar archivos por tipo y fecha, y observar que
dichos documentos muestran, a su derecha, un icono en forma de chinche o pin, que se puede

pulsar para que esos documentos se queden permanentes en la lista de documentos recientes, de
modo que tengan un facil acceso.

© Barra de herramientas Quick Access
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Annotate

2

Home  Insert Para
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Se ubica a la izquierda del menu de aplicacion. En esta barra se encuentran los comandos de uso
frecuente.

Dimlinear
<" Dimlinear
Dimlinear

Circle

Circle

Circle
Circle
Circle

Line

Undo 1 command

Para agregar mas comandos, haga clic derecho sobre la barra Quick Access y seleccione Customize
Quick Access Toolbar. Se muestra el didlogo Customization User Interface o CUI, y se muestra la
lista de comandos posibles. Elija el comando deseado y termine con OK o arrastre el comando que
desee agregar desde el panel de Command List hacia la barra de herramientas Quick Access.

Customize Quick Access Toolbar 3

Show Quick Access Toolbar below the Ribbon
= =) g

Prop

Draw ~ Annotation +

A
Customize | Transfer
‘ Customizations in All Files 3| Button Image A
lj Aoplyto @l@e] A
Command List: 3 1
—i Osmalimage || 1 | &7 <+
|Q B Olssemse (9,00
All Commands Only v| 7o @ Beth W@ A
&7 @ ,
Comman Sourcs - Bpor [o]=
3 3 Poirt ACAD
‘B 3D Adjust Clip Planes ACAD
L& 3D Adjust Distance ACAD
B 3D Aign ACAD Reset Defaults
B 30 Amay ACAD
1 3D Constrained Orbit ACAD
&5 3D Continuous Orbit ACAD g;”'” gia":"'“” T
é ig ?EE Ot EE Eﬂemn:e\pﬁ\e =
Ef e o e e
St Macro “CC_mimor3d
«*» 3D Move ACAD Tags
{ 3pomit ACAD R
B,
3D Gsnap Settings ACAD Element ID 1D_Mimor3d
4 30 Pan ACAD 4 Images
2 3D Poline ACAD Smallimage RCDATA_16_3DMIRROR
@ 30 Rotate ACAD Large image RCDATA_32_3DMIRROR
4, 3D Scale ACAD
3D Studio... ACAD
D Suraces... ACAD
8 3D Swivel ACAD
3D Wak ACAD
4% 3D Walk and Fiy Seitings ACAD e
@, 3D Zoom ACAD
© 3oowr ACAD
@ About ACAD
L T arae i Anan
[ok | [ Coea oy | [ | ®
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Es una funcién que se utiliza para varios productos del Autodesk, y consiste en un conjunto de
herramientas en la parte derecha de la barra del titulo, que permiten acceder a varias fuentes de
informacion relacionadas con los productos de AutoCAD.

Es un buscador que permite obtener informacién sobre las interrogantes de comandos nuevos u
opciones nuevas del software.

ﬁ Autodesk AutoCAD 2015  Drawing3.dwg "V ARRAY POLAR

» Autodesk AutoCAD 2015 - Help = =
4 pr ‘ Home >
A AUTODESK® AUTOCAD" 2015 ‘ HELP \ Sign In @ English

~
Q About Polar Arrays @ LIKE (0) < SHARE
ARRAY POLAR (@7
- In polar arrays, items are evenly distributed about a center point or axis of rotation.
All Content | v [ |V
When you create a polar array using the center point, the axis of rotation is the 7 axis of the

Search results: 27 current UCS. You can redefine the axis of rotation by specifying two points.
About Polar Arrays base point: user-defined

In polar arrays , items are evenly distributed
about a center point or axis of rotation. When you
create a

2014-07-07

About Creating Polar Arrays (VBA/Activex)
You can array all drawing objects to fill a circular
pattern. To create a polar array ...

2014-09-01

center point
To Work With Polar Arrays

How to create and edit polar arrays . Create a
Polar Array Click Home
2014-07-07
0 :0
: axis of rotation 4!

Except where otherwise noted, this work is licensed under a Crealive Commons Alfribution-MonCommercial-ShareAlike 3.0 Unported License.
Piease see the Autodesk Creative Commons FAQ for more information.

\ AUTODESK. Knowledge Network

© Autodesk 360

Es una plataforma basada en una nube, que ofrece un mecanismo de almacenamiento de archivos,
es decir, es un espacio de trabajo y de servicios de la nube para ayudarle a mejorar significativamente
el modo de disefiar, visualizar, simular y compartir el trabajo con otros usuarios en cualquier
momento y en cualquier lugar. Esto se detallara mas adelante en el capitulo de novedades.




Primeros pasos

2 Signin
Sign In

ut /

vy Autodesk - Sign In

{\ AUTODESK. i 5

%@wth an Autodesk Acco
Autodesk ID or e-mail address

Password

Forgot your password?

Need an Autodesk ID?

© Autodesk Exchange Apps

Esta opcidon permite acceder a la pagina web de Autodesk Exchange Apps, en la que se podra buscar
opciones para utilizar aplicaciones de Autodesk.
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Permite acceder a las actualizaciones de los productos y conectarse a la comunidad de AutoCAD en
linea, ademas de ingresar a cuentas y redes sociales como Facebook y Twitter. A partir de AutoCAD
2015, podra ingresar a YouTube y asi poder ver tutoriales.
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Permite acceder a mecanismos de ayuda e informaciéon de AutoCAD, asi como a ventanas de
bienvenida, tutoriales, descarga de archivos, Help, etc.

3 Autodesk AutoCAD 2015 - Help -
A P | Home )
A AUTODESK® AUTOCAD" 2015 | HELP signin & English
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Q About Arrays & LIKE (0) & SHARE
| ARRAY [a]
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Search results: 376
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About Arrays + Path

Create copies of objects arranged in a pattern « Polar
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ARRAY (Command) “‘

Creates copies of ebjects arranged in a pattern.
You can create copies of objects in a regularly
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About Path Arrays “‘ w
In path arrays , items are evenly distributed along
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Except where othenwise noted, this work is licensed under a Creative Com A -ShareAlike 3.0 Unported License.
S B Flease see the Autodesk Creative Commons FAQ for more.
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Ahora puede cambiar el idioma de Help rapidamente y asi tener una informacién mucho mas clara.

» Autodesk AutoCAD 2015 - Help = =
4 b | Home )
é AUTODESK” AUTOCAD' 2015 | AYUDA Iniciar sesion €3 Espafiol
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o = Acerca de las matrices (GRS
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Consulte las Prequntas frecuentes de Autodesk acerca de Creative para obtener mas 6
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@ Cinta «ribbon»

Las cintas ribbon proporcionan una ubicaciéon simple y compacta para las operaciones que son
relevantes al espacio de trabajo actual (2D, 3D).

Output  Add-in

AT

Ted ' L
oM

Las presentaciones de las cintas pueden ser minimizadas para ver solo titulos de fichas (tabs),
minimizando titulo de paneles, mostrarse en botones de paneles o completa.

i ‘.‘ Sign In
[ ———— T T ]
Minimize to Tabs
Minimize to Panel Titles

Match
- Prope Minimize to Panel Buttons

Cycle through All

Autodesk AutoCAD 2015  Drawingl.dwg ™ o % Signin

Minimize to Tabs

S
-~ -~
i . - . -~ Minimize to Panel Titles
Block e ¢ Utilities  Clipboard ~ View -~
’ v Minimize to Panel Buttons

Drawing1™

1 Minimize to Panel Buttons
[-][Te ]
Press F1 for more help
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Los paneles pueden colocarse como flotantes simplemente arrastrandolo hasta el espacio modelo.

Autodesk AutoCAD 2015  Drawingl.dwg
tate  Parametric v  Manage Output Add-ins  Au
- s () Rotate - Trim » & A [ Linear =
s, Copy A Fillet ~ = * Leader -
.Y Scale mm Aray - it
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” " Annotation Utilities «

i o -
Line Polyline Circle  Arc
- - & -
”

Draw
Drawingl
[—1To
-
= Make Current
=,

Lay
=

p"Z'F-EFt'ES L Match Layer

Las cintas pueden ser personalizadas y crear sus propios paneles. Ademas, se pueden modificar los
comandos y los controles de los paneles en cintas existentes. Para crear o modificar un panel de
cinta, se usa el editor CUI (Customize User Interface). Cuando se trabaja con paneles de cinta, se
pueden crear nuevas filas o subpaneles para organizar los comandos y controles.

] 2 Impe
cur
User
Interface Palettes ¢ Fdlit Aliases -

ation

A Customize User Interface o 1=
Customize \T,E"g;\
Customizations in All Files 2 Properties Py
A C Files vz | B m
=44 ACAD " 12 | =]
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¥ Drafting & Annotation Defaut (curent) Name ACAD
L 3D Modeling Display Name AutoCAD
£# 3D Basics Filename. C\Users\UNIMASTER App D
{5 Quick Access Toobbars
{3 Rbbon
1L Toobars
Merus

B9 Quick Properies
g Rollover Toottips
Shortout Menus

L[ Keyboard Shortcuts
@ Double Click fictions

{3 Mouse Buttons o5
Command List: 2
I | Q
All Commands Only v| 75
Command Source A
3 3 Point ACAD
P 3D Adust Clip Planes ACAD
B 30 Adust Distance ACAD
£ 30 Aign ACAD
6 30 Amay ACAD
{1 3D Constrained Orbit ACAD
&5 3D Cortinuous Orbit ACAD General
~— 3DRy ACAD
& 3D Free Onbit ACAD
g 30 Mimor ACAD v

ok | [ cancel Aoply e | ©

Luego de crear o modificar un panel, se puede mostrar en una ficha de
la cinta. Las fichas de la cinta son usadas para agrupar los paneles de
cintas similares.
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16.4 Ayudas extendidas - Extended tooltips

Las ayudas dependen de dos niveles de contenido: basico y extendido. Las ayudas extendidas
proporcionan informacién adicional sobre un comando o control, y puede mostrarse con una gréfica al
dejar el cursor sobre el objeto. Se puede afiadir informacién para personalizar los comandos mediante
el CUIL.

PUE=E = s =«- -7 Autodesk AutoCAD 2015 Dra

Home  Insert e Manage  Output  Ad

e pTom e O s
' e- % a
w7 & @
@Hat:h

M| Gradient

Fills an enclosed area or selected ohjects with a gradient fill

A gradient fill creates a smooth transition between one or two
colors,

' GRADIENT
Press F1 for more help

1.6.5 Action Recorder

La Action Recorder es un grupo de la cinta de opciones que contiene herramientas que permiten
grabar, modificar y reproducir una macro de acciones. Esta grabadora se ubica en la ficha Manage,
se selecciona el icono Record y se dibuja automaticamente. Se grabaran las acciones en el
recuadro.

Interface Palett: ,';,, dit Aliases -

tion

Drawing2*

Mientras se graban, las acciones, los comandos y los valores de entrada se capturan y se muestran
en el arbol de acciones como nodos de valor. Un nodo de valor graba la entrada proporcionada en una
solicitud dentro de un comando, incluidos los puntos adquiridos, las cadenas de texto, los nimeros,
las palabras clave u otros valores que se especifiquen al grabar un comando. Esto no requiere de
ninguna experiencia en programacion.
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Cancel Help

1.7 HERRAMIENTAS DE VISUALIZACION
Cubo de vistas

Permite modificar el punto de vista del observador en el espacio modelo, WCS (Sistema de Coordenadas
Universales), o también del sistema de coordenadas UCS (Sistema de Coordenadas del Usuario);
ademas, se puede recuperar un UCS grabado.

Al hacer clic en la casita, se obtiene una vista 3D isométrica con perspectiva.

Se puede activar y desactivar el cubo de vistas con el comando Navcube.
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La configuracién del cubo de vistas se realiza haciendo clic derecho sobre el cubo y seleccionando la
opcion ViewCube Settings.

=
Home I
Parallel &b
Perspective &
Perspective ith Ortho Fgfes
Set Current View as
ViewCube Settings...

Help

Desde esta ventana puede controlar las propiedades de visualizacién de la herramienta ViewCube.

'y ViewCube Settings n
Display
On-screen position: Top Right v
ViewCube size:
Automatic
Tiny D Large ¢
Small  Mormal
Inactive opacity:
Low U High
2 %
Show UCS menu

When dragging on the ViewCube
Snap to dosest view

When dicking on the ViewCube

Zoom to extents after view change
Use view transitions when switching views

Orient ViewCube to current UCS

Keep scene upright

B [¥]5n0w compass below the ViewCube

Restore Defaults

[ o | [ concd | [ v |

1.7.2 | Barra de navegacion

Esta barra se activa automaticamente al abrir el AutoCAD. En esta barra tenemos cuatro formas de
navegar, que son:

+ FULL NAVEGATION WHEELS- QUE ES LA RUEDA DE
NAVEGACION

+ PAN-MANO QUE PERMITE MOVER PANTALLA SOBRE EL
ESPACIO MODELO

+ ZOOM - PERMITE OBTENER DIFERENTES TIPOS DE LUPAS
« ORBIT - ORBITAS PARA 3D

«  SHOW MOTION PERMITE OBTENER VISUALIZACIONES DE
PANTALLA .

Para abrir o cerrar podemos hacerlo con el comando Navbar y luego la
opcion On - Off.
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1.7.3 Steering wheels

Estas ruedas estan divididas en sectores, y cada sector contiene una sola herramienta de navegacion. Se
puede activar una herramienta haciendo clic en el sector y haciendo el arrastre segin el tipo de herramienta.

Por defecto, aparece la rueda en la opcién Full Navegation, la misma que tiene los siguientes comandos:
4 Zoom y Pan, para hacer acercamientos y desplazamientos en pantalla.
A Orbit, para cambiar la visualizacién en 3D.
A Rewind, que permite recuperar vistas en pantalla.
A Center, que permite cambiar el punto pivote para la navegacion en 3D con la tecla Ctrl.

>

Up/down, para modificar una elevaciéon 3D.

Abrir el archivo CO1 STEERING WHEELLS.dwg.

Autodesk AutoCAD 2015 FAAUTOCAD 201..\CO1 STEERING WHEELLSdwg
Exp s

PR 5% - 7ype o comnand 3 s i =

MODEL it i ~ v RRANMY B+ O R B=

Seleccione el icono de Steering Wheells, la opcién Walk.




Show Motion

Permite recuperar vistas nombradas previamente, creadas en el dibujo actual, que permite organizarlas
en categorias de secuencias animadas. Ademas, se pueden utilizar para hacer presentaciones y
chequear proyectos.

Abrir archivo CO1 SHOW MOTION.dwg.

Luego, seleccione el icono Show Metion.

ShowMotion

Pravides an on-screen display for creating and playing back
cinematic camera animations for design review, presentation, and
bookmark-style navigation.

Seleccione la opcion Nuevo.

0 [> [TCtD x|

En la ficha Shot Properties se pueden ajustar las transiciones entre las vistas, el tipo de movimiento,
la posicién de la camara y la duracion de la grabacion; sin embargo, las opciones disponibles cambian
dependiendo del tipo de visualizacion. Por ejemplo, si el tipo de vista cambia, entonces se puede
cambiar la longitud de la grabacién, mas no la posicion de la camara.
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Se configura de esta manera:

A New View / Shot Properties

View name: ‘ vo1 |
View category: ‘ <None> \ vl
i "

View type: ‘C\nemahc \ v|
View Properties | Shot Properties

~
Transition ””
Transition type: -
P i
|Fade from his shot v

3 2] Transition duration (seconds)

<
Motion é—’,

Movement type: Jadf

|orbit v

e >
Duration: 3 % seconds

EEore.
o

\
1
[ e Vg

| oK | ‘ Cancel | | Help

Ahora, para ejecutar:




Este comando permite fijar en el fondo de la vista un color de fondo.

Abra el archivo CO1- BACKGROUND.dwg.

Match

2
Propei v

Utiities +  Clipboard

MoDEL i i ~|h &~ N\ - O-RKXKAm~-@ -+ LS

Escriba el comando Background.

—4
¥
&
=
¥
r
¥
-

{53 BACKGROUNDPLOT

{88 BACKZ

Bl HATCHTOBACK

{53 HPBACKGROUNDCOLOR
&= HYPERLINKBACK
) (= -5/ GROUNDS
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A Background

Type:

Preview

‘
I
Image options
| | Browse, |

Adjust Image... Select an image file and click Open.

o | [ | [ rep |

Haga clic en OK y obtendra la siguiente imagen:

A Background H

Type: |1mage v|

Preview

Image options 4

| D:AUTOCAD 2015 cnp\cm—mz\m% Browse...

Adjust Image... ‘

[ox ] [l | [ 5
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